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 Overview 

Manual Profile 

This manual provides a description of the customer software available for 
the Wide Format Print Systems 510 Series, 721P, 6204, 6050A, and 
6279. It also provides general information about installing the software on 
your PC and using it with the Printer and Scan System. 

NOTE:  For the 6030 Wide Format and 6050 Wide Format printers, which 
have their own embedded controller, the FreeFlow Accxes Print Server is 
required to use the Web Printer Management Tool. 

This manual is primarily a training aide. You will be reading and using 
various software help files and sections user guides. Study only those 
sections of this manual that pertain to the software that you will be using. 

As you go through the training, you can install the software and set up the 
system and your workstation to meet your printing requirements. 

Remote access software 

The following software tools are covered in this manual: 

• Web Printer Management Tool  

• Account Management Tool (AMT) 

• FreeFlow Accxes Client Tools  (ACT) 

NOTE:  If you are already familiar with using these software tools, you 
can skip this training document. Instead, update your understanding by 
reading over the “New Features” section of the current FreeFlow Accxes 
Release Notes. Go to www.xerox.com to locate the current Release 
Notes.  

http://www.xerox.com/


 

2                                                                                 FreeFlow Accxes Software Tools Customer Training Guide 

Training password 

Access to some of the features covered in this training requires a system 
password. Only the Key Operator or System Administrator should know 
this password. For this training, the Key Operator or System Administrator 
should set up a temporary password and make it available to training 
participants. After the training is complete, the password should be 
changed to protect the system from unauthorized entry. 
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Job Accounting and Scan-to-Net enablement 

Job Accounting 

Job Accounting provides a means of tracking all usage for copy, scan, 
and print jobs with User ID and Account IDs. It is an optional feature on 
the Wide Format Print Systems. 

Job Accounting has three modes: 

• Enabled – When Job Accounting is set to Enabled, users must 
provide a valid User ID and Account ID to copy, scan, or print. 
Media usage and Scan System usage data are logged to the 
specified user/account.  

• Disabled – When Job Accounting is set to Disabled, users can 
copy, scan, or print in the normal manner without entering account 
information. No media usage is logged. 

• Optional – When Job Accounting is set to Optional and users 
enter User ID and Account ID, media usage for jobs is logged in the 
same way as when set to Enabled. Media usage for jobs without 
user and account IDs is logged to a generic user/account. Jobs with 
invalid IDs are printed with an error page. 

To set the Job Accounting mode, you must use the printer control panel, 
the Scan System control panel, or the Web Printer Management Tool. 
The System Administrator creates user IDs and Account IDs with the 
FreeFlow Accxes Account Management Tool (or another external job 
management tool) installed on a workstation connected to the network. 

The data that is created by using the Account IDs and User IDs is stored 
in the job log file in the printer’s controller. An external account server, 
such as the Account Management Tool, retrieves the data.  

To order the job accounting feature, contact your Xerox representative or 
authorized reseller. 

Scan-to-Net images saved on the hard disk 

Scan-to-Net allows you to scan documents and store them on a hard disk 
for later retrieval from a workstation connected to the network. 

To order the Scan-to-Net feature, contact your Xerox representative or 
authorized reseller. 
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Scan-to-Net images sent to a remote destination 

The Scan-to-FTP and Scan-to-Remote Printer (this feature is called Total 
Accxes) features are accessed when the Scan System is in Scan Mode. 
This is a security feature to allow Scan-to-Net images to be transferred to 
one of 16 remote FTP or printer destinations. The scanned image data 
will not be left on the FreeFlow Accxes controller’s hard drive for FTP 
files. For files scanned to remote printers, the scanned image data will be 
left on the controller’s hard drive.  

The destination choices that show on the scan system’s Sample Mode 
screen were defined on the Web Printer Management Tool on the 
[Configuration > Scanner] page. See the “Sample Mode” section of this 
guide for more information on how to use this feature.  

The Wide Format Print Systems 510 Series, 721P, 6204, 6030/6050, 
6050A, and 6279 can all be connected to a Wide Format Copy System, 
an integrated solution for electronically scanning and then printing good 
quality copies of the images for engineering or architectural sized 
documents.  

The 6204 and 6279 printers can also be installed with a built-in scanner. 
See the Xerox 6204 Wide Format Solution Copy/Scan User Guide for the 
FreeFlow Accxes Print Server V13.0 or the Xerox 6279 Wide Format 
Solution Copy/Scan User Guide for the FreeFlow Accxes Print Server 
V13.0 for comprehensive scan instructions for their unique touch screen 
user interfaces. 

NOTE:  If the Image Overwrite feature is enabled, Scan to FTP is still 
available, since Scan to FTP files are not left on the hard drive. But since 
images are deleted from the hard drive when Image Overwrite is enabled, 
the Scan to Remote Printer feature is disabled while the Image Overwrite 
feature is in effect. See the Setup of Network Destinations section for 
more detail on the Scan to FTP and Scan to Remote Printer features. 
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Web Printer Management 
Tool 

Module introduction 

This module describes the Web Printer Management Tool. It is part of the 
controller firmware that supports the Wide Format Print Systems 510 
Series, 721P, 6204, 6050A, and 6279. 

The 6030/6050 Wide Format Print System needs to have a FreeFlow 
Accxes controller connected to it in order to use the Web Printer 
Management Tool. It is accessed using a Web browser. 

The Web Printer Management Tool provides the following functions: 

• Print job management 

• Printer default parameter set-up 

• Job accounting mode selection 

Objectives 

When you have finished this module, you should be able to: 

• Log on to the Web Printer Management Tool 

• Upload a file to the printer 

• Understand the features offered by Web Printer Management Tool 

• Understand Instant Accxes 

• Understand Setup of Scan to Network Destinations 

• Monitor print jobs 

• Set printer defaults (Key Operator or System Administrator). 
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Materials Required 

You must have the following items before beginning this module: 

• Wide Format Print System 510 Series, 721P, 6204, 6050A, 6279, 
or the 6030/6050 Wide Format printer with the FreeFlow Accxes 
Print Server loaded with FreeFlow Accxes Firmware 13.0 

• The IP Address of the printer 

• A copy of the 13.0 FreeFlow Accxes Firmware Release Notes 

• A copy of the Xerox FreeFlow Accxes System & Web Printer 
Management Tool Setup Guide 

• Browser connection - Firefox 2.0 (or higher) or Microsoft Internet 
Explorer 5.5 (or higher) 

 



 

FreeFlow Accxes Software Tools Customer Training Guide                                                                                 7 

Web Printer Management Tool Overview 

The Web Printer Management Tool is a browser-based tool. Although it is 
not part of the World Wide Web, the Web Printer Management Tool has 
the look and feel of a Web page. The Web site is the printer's controller. 
You can access the Web site from a client workstation by using either the 
Firefox 2.0 (or higher) browser, or Microsoft Internet Explorer 5.5 (or 
higher) browser, and entering the URL address of the printer's controller. 
The URL address in this case is the IP v4 or v6 address of the controller. 
The monitor on the workstation used to interface with the controller must 
support a minimum resolution of 1024 x 768. 

Any user can view the Web Printer Management Tool pages. If the 
password has been changed from the default number zero, a password is 
required to make changes on the Web Printer Management Tool. The 
System Administrator often changes the password to prevent 
unauthorized changes. 

Web Printer Management Tool capabilities 

The Web Printer Management Tool allows you to: 

• View printer status (including media inventory) and the print queue 

• View the printer defaults 

• View the Job Accounting mode for remote print jobs 

• Generate test prints showing configuration data (such as the 
Controller's TCP/IP address) 

In addition, if the password is set to zero or you know the password, you 
can: 

• Shut down the YKE, YKE-N, FRX, or LVX controller from the 
Utilities > Shutdown screen. 

• Change the priority and delete jobs in the print queue 

• Set up all printer defaults 

• Load stamps 

• Specify the Job Accounting mode for remote print jobs 

• Upload controller and printer firmware updates 

• Upload Feature Keys to the Controller (some examples include: 
Scan-to-Net, Scan-to-Print, PostScript, Job Accounting, 5D speed 
update for the 6204 printer, 9D speed update for the 6050A and 
6279, TurboScan, AutoCAD or CAD upgrades, or color scan 
enablement).  
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NOTE:  See the Configuration > Features page on Web Printer 
Management Tool for a list of available Accxes, Printer, and 
Scanner features. This page lists whether the feature is installed 
and provides its current status (enabled or disabled). 

• Enable or disable the media mismatch queue from the System 
Defaults > Media page of the Web Printer Management Tool. 

• Use the Rendering Page to change the printer default settings for 
such image rendering parameters as Contrast, Lightness, Vector 
Halftone reproduction (area fill or fine line optimization), and Fineline 
Grayscale Rendering (grayscale rendering of colored lines).  You 
can also set the printer’s default rendering to a choice of graphics, 
photo, or lines & text document types. 
 

The performance of the Web Printer Management Tool, in terms of user 
wait time, is determined primarily by: 

• Network bandwidth and speed 

• Amount of data being transmitted to or from the printer's Controller 

• Network traffic 



 

FreeFlow Accxes Software Tools Customer Training Guide                                                                                 9 

Starting the Web Printer Management Tool 

Do the following to connect to the Web Printer Management Tool. 

1. In the browser URL box enter http:// followed by the printer’s IP 
v4 or v6 address. For example: http://13.240.20.38.  
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2. Select Configuration > Network. Check that the Subnet Mask, 
IP Address, and Gateway settings are correct.  

 
NOTE:  These are needed so that your workstation will be able to 
communicate with your FreeFlow Accxes-compliant Scan System and 
printer. If you don’t know the printer’s Subnet Mask, IP v4 or v6 Address, 
or Gateway settings, see your System Administrator or the test print set 
produced at the time of your printer’s installation. 
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6030/6050 Wide Format printers only: The 6030/6050 printer has a built-
in controller, unlike the other Xerox Wide Format print and scan systems. 
Users who use the Accxes Tools and drivers to interact with their other 
Xerox printers may wish to set up their 6030/6050 to behave like their 
other Accxes-driven printers. To do this, configure a remote printer page 
as follows. 

1. Select [Utilities > Remote Printer].  

 
2. Put in the IP address of the remote printer, and the job queue 

name of that printer, where FreeFlow Accxes will send the print 
job data to the 6030/6050. The remote job queue is in the plt 
(00-99) format, with an extension letter of t, c, h, p, v, or NONE. 
Your choices will show on the screen, for example: (plt00t). An 
example queue name is "plt99" when NONE is selected.  

3. Press the [Update Printer] button to set your choices. 

4. Select [Configuration > Network] and make sure that the 
settings match those set up on the [Utilities > Remote Printer] 
page.  

NOTE:  This is not the same thing as setting up a remote printer on Total 
Accxes, which allows you to send scan jobs to a networked file server 
destination or to a remote printer (a printer other than the local printer 
where the scan operation is performed). For more information on that 
feature, see the Scan to Total Accxes section under Setup of Scan to 
Network Destinations. 
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Using the Web Printer Management Tool  

System Requirements: Read over the help file that describes the 
software and hardware that is needed to use the Web Printer 
Management Tool. Access the help file by doing the following on the Web 
Printer Management Tool screen. 

1. Click on the [Help] button in the upper right hand corner.   

2. Choose the Web Printer Management Tool System 
Requirements link from the Index.   

Overview: Read over the help file that gives you an overview of the Web 
Printer Management Tool. You get to the help file by doing the following 
on the Web Printer Management Tool screen. 

1. Click on the [Help] button in the upper right hand corner.   

2. Choose the Web Printer Management Tool Overview link from 
the Index. 

Quick Start: Do the quick start tutorial to give you the practical skills for 
using the user-friendly Web Printer Management Tool.  

1. Click on the [Help] button in the upper right hand corner.   

2. Choose the Quick Start link below the Index. You can skip the 
first section, which talks about starting the Web Printer 
Management Tool, since you’ve already done it. Instead, start 
with the “Printer Queue and Job Queue” section.  

To become aware of other options for which a System Administrator 
might want to change the defaults, refer to the Index help file or look in 
the Xerox FreeFlow Accxes System & Web Printer Management Tool 
Setup Guide.  
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Uploading a print job from Web Printer Management Tool 

To upload a file from your system to the printer, follow the instructions 
below. Files can be any type supported by the printer. 

1. Select [Utilities > Upload]. 

 
2. Select the [Browse] button to locate the file. Double-click on the file to 

select it. 

3. Select the [Upload] button to transfer the file to the printer. 

NOTE:  This option allows you to send a file to the printer, but does not 
allow you to select job options, such as scaling or auto rotation. See the 
section later in this guide on Account Client Tools for details on how to 
submit a job and modify the default print options. 
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Instant Accxes 

Instant Accxes is a Web Printer Management Tool application that allows 
users to set up folders with specified printing options on their personal 
workstation.  

Setting up Instant Accxes folders is an administrator function. Once these 
folders are set up, any user can place files into these folders, and they will 
be printed with the assigned printing options.  

The system administrator password default is zero. The administrator can 
change this to restrict access. 

Follow these instructions: 

1. Enter your printer’s IP v4 or v6 address. For example: 
http://13.240.20.38 

2. Select the Applications tab.  

 
3. Select the Instant Accxes tab. The Instant Accxes Server 

Setup page displays. 

4. Select the <Enable Instant Accxes> check box. 
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5. Select the number of folders you desire (range is from one to 
ten) from the Active Instant Folders drop-down list. 

6. Enter the Server Name, Server Description, and Server 
Workgroup. 

NOTE:  These are meaningful names you assign to the server that help 
you identify it. See the Help for detailed information on these values. 

7. Select the [Submit] button to submit the server setup values. 

8. Select a folder from the [Print Options] drop-down list. 

9. Select your desired print options (number of copies, media type, 
etc.). 

10. Select the [Submit] button to submit the print options. 

Once the administrator defines the Instant Accxes folder(s), users can 
mount them on a personal workstation through network neighborhood in 
Windows.  

1. Select [Start: Run] on your workstation. The Windows Run 
screen displays. 

2. Type in \\ followed by the IP v4 or v6 address of your printer. For 
example: \\13.240.20.38. 

3. Select [OK]. 

4. Select one of the Instant Accxes folders from the list of folders. 

5. Drag and drop the folder to your desktop and rename it with a 
useful name to describe the printing parameters that you set up. 

Once you have set up your Instant Accxes folder, you are then able to 
place files into the folder. Any file placed into the folder will be printed 
using the parameters defined when the folder was set up.  

NOTE:  If the Image Overwrite feature is enabled, Instant Accxes is not 
accessible. 
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Setup of Scan to Network Destinations 

 
The Configuration > Scanner page of the Web Printer Management 
Tool allows the user to use the Scan-to-Network service to send scan 
jobs to a networked file server destination or to a remote printer (a printer 
other than the local printer where the scan operation is performed). Scan-
to-Network can be performed on any printer with version 13.0 that has the 
Scan to Net Key enabled. If this feature is not enabled, the Scanner tab is 
not available from the Configuration menu. 
The user may configure up to 16 FTP (file transfer protocol) destinations, 
each of which can be FTP or Total Accxes destinations. The default 
Accxes operation is to store scanned files on its hard drive and make the 
files available for users to retrieve via FTP.  The default password is set 
to 0 (zero). With that password, any user can set up a remote printer. 
Once the system administrator changes the default password, general 
access is denied. Passwords are changed on the [Utilities > Password] 
screen. The [Session Setup] screen is the login page where passwords 
are entered. 
With configurable scan destinations, Accxes can also automatically move 
the files to a remote server. The remote server must be capable of 
receiving files via FTP. If Accxes is unable to send a file to a remote 
server, an error will be displayed on the scanner control panel. Once a 
scan destination has been configured, scanner users can choose a 
destination via the Sample key on the scanner control panel.  
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Scan to FTP 

If you select to Scan to FTP: 
1. Select [Configuration > Scanner]. 

 
2. Select a Scan Destination number from the drop-down 

menu. 

3. Select the FTP option button in the Mode area of the screen. 
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4. Enter the following: 

o FTP IP Address - The IPv4 or IPv6 address of the 
remote server 

o FTP User Name - Account name to use for logging into 
the remote server 

o FTP Password - Password for the above account 

o FTP Nickname - A descriptive name for this FTP location 
that will be displayed when selecting the destination from 
the printer UI. 

o Remote Directory - Destination directory for scanned 
files 

o Remote File Prefix - Remote file names will start with this 
alphanumeric string. 

o Remote File Index - Remote file names will end with this 
numeric value. This number will automatically increase 
after every scan. 

5. Select the [Update Printer] button. 

6. Mark the <Allow local file> check box if you wish to allow 
scans to the Accxes file system (hard drive).  

You are then able to retrieve the file later using Accxes 
Client Tools. The file is saved on the hard drive for a period 
of time specified by the administrator. 
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Scan to Total Accxes 

The scan to a remote printer feature is called Total Accxes.  

If you select Scan to Total Accxes: 

1. Select [Configuration > Scanner]. 
2. Select a Scan Destination number from the drop down 

menu. 

 
3. Select the Total Accxes option button in the Mode area of 

the screen. 

4. Enter the following: 

o Remote Printer - A user defined name for this printer. 
(No duplicate names are allowed.) This name will be 
used to reference this printer on the network for job 
submission and reporting status. 

o Printer Name - A drop down list of the supported printer 
classifications. 

o Printer Nickname - A descriptive name for this printer 
that will be displayed when selecting the destination from 
the printer UI. 

o Printer Description - General, descriptive details 
associated with each printer. 

o IP Address - The IPv4 or IPv6 network address of this 
printer. 
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o Preview - If enabled, will cause the scanned image to be 
held in the TotalAccxes Queue where it can be 
previewed and then submitted or deleted. 

o Remote Queue Name - When making selections of LPD 
or CIFS the "Remote Queue" Field can be used. If using 
LPD, this field contains the remote LPD queue name. 
For the CIFS selection, this is the printer share name 
specified when setting up the shared printer on a 
Windows™ system. 

o Connection – Determines how Accxes will communicate 
with this printing device. Choices are LPD or CIFS (a 
shared printer from a Windows™ workstation).If the 
CIFS option is selected, the User ID, Password, and 
Server Workgroup fields appear. 

o User ID – When selecting Microsoft Windows™ as the 
connection type the "User ID" field will appear. This is 
the Windows™ user name that will be used to access 
the printer share. 

o Password – When selecting Microsoft Windows™ as the 
connection type the "Password" field will appear. This is 
the Windows™ user password that will be used to 
access the printer share. 

o Server Workgroup – When selecting Microsoft 
Windows™ as the connection type the "Server 
Workgroup" field will appear. This is the Windows™ 
workgroup that will be used to access the printer share. 

o Job Name - The default job name assigned to jobs going 
to this printer. 

o Media - The default media that will be assumed when 
sending a job to the remote printer. 

o Copies - The default copy count assigned to each 
remote printer job. 

5. You may submit a test print to the printer to validate proper 
setup/ configuration. 

6. Select the [Update Printer] button. 

7. Mark the <Allow local file> check box if you wish to allow 
scans to the Accxes file system (hard drive). 

You are then able to retrieve the file later using Accxes 
Client Tools. The file is saved on the hard drive for a period 
of time specified by the administrator. 
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A Scan to Net destination of TotalAccxes is available only on systems 
with at least 2GB of installed RAM if Image Overwrite is disabled. 

By default, Accxes temporarily stores scanned files on its hard drive, 
sends them to the remote printer, and then deletes them. However, you 
can specify that the image will be previewed prior to printing. In this case 
the image will be made available for viewing and printing from the 
TotalAccxes Queue page on the Printer Queue tab. These preview files 
will be deleted as determined by the file deletion timeout setting, or once 
the job has been submitted or deleted by the user. 

You can also view the status of remote print jobs by selecting [Printer 
Queue > Total Accxes Queue]. The Total Accxes Queue option allows 
users to monitor the activity of remote printers enabled by the Total 
Accxes feature. By defining a scan destination as a Total Accxes printer, 
scanned images can be sent directly to that printer or can be held in the 
Total Accxes queue for preview purposes. Once previewed, the scanned 
image’s copy count can be modified and then released for printing to the 
Total Accxes printer or deleted. In addition, active or completed Total 
Accxes jobs are listed here. The [Clear All] button provides a method to 
cancel and clear the entire Total Accxes queue with one operation. 

Users may then select a FTP or remote printer destination at the printer 
using the Scan to Network feature on their user interface. 
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Check your understanding of the Web Printer Management Tool 

 
1. What are the recommended browsers to use with the Web 

Printer Management Tool? 

____________________________________________________ 
2. Is a printer password required to make changes to the Web 

Printer Management Tool printer settings? Yes or No 

3. Can the browser access the Web Printer Management Tool 
through a proxy? Yes or No 

4. To use the Web Printer Management Tool, the printer must be 
connected through a __________ port using 
__________________ protocol. 

5. What three factors determine wait time on the Web Printer 
Management Tool? 

___________________________________________________ 

___________________________________________________
___________________________________________________ 

6. Without a printer password, can any user view the printer default 
parameters and Job Accounting mode information? Yes or No 

7. How do you access the help files on the Web Printer 
Management Tool? 

____________________________________________________ 
8. Where can you look on the Web Printer Management Tool to 

see what media sizes are in the printer? 

____________________________________________________ 
9. When viewing the list of print jobs on the Main page, select 

_________________ to update the status of all the print jobs. 

To view only the active print jobs, on the Main page, select 
_________________. 

10. If you are using a printer password, how can you cancel a print 
job? 

____________________________________________________ 
11. When you view the print jobs on the Main page, sometimes the 

word “mismatch” will show as the job’s Status. What creates a 
mismatched job and how do you solve it so that you can 
continue printing? 

____________________________________________________ 
12. What page does the Administrator access to select Optional as 

the Accounting Mode? 

____________________________________________________ 
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Answers to Web Printer Management Tool Questions 

1. What are the recommended browsers to use with the Web 
Printer Management Tool? 

Netscape Navigator 7.0 or higher or Microsoft 
Internet Explorer 5.5 or higher 

2. Is a printer password required to make changes using the Web 
Printer Management Tool printer settings?   

Yes, if the password has been changed from zero. 
3. Can the browser access the Web Printer Management Tool 

through a proxy?  

No 
4. To use the Web Printer Management Tool, the printer must be 

connected through an Ethernet port using TCP/IP protocol. 

5. What three factors determine wait time on the Web Printer 
Management Tool? 

Network bandwidth (speed) 
Amount of data being transferred to or from the 
printer 
Network traffic 

6. Without a printer password, can any user view the printer default 
parameters and Job Accounting mode information?   

Yes  
7. How do you access the help files on the Web Printer 

Management Tool? 

Select the Help button in the upper right corner of 
your screen. 

8. Where can you look on the Web Printer Management Tool to 
see what media sizes are in the printer? 

 
Select Printer Queue.  The media sizes for each of 
the printer’s drawers are listed. 

9. When viewing the list of print jobs on the Main page, select Get 
Status to update the list of all the print jobs. 

To view only the active print jobs, on the Main 
page, select Printer Queue > Active Queue. 

10. If you are using the printer password, how can you cancel a print 
job? 
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Select [Printer Queue > Active Queue]. Select 
[Cancel] from the Status dropdown list and then 
select [Update Printer]. 

11. When you view the print jobs on the Main page, sometimes the 
word “mismatch” will show as the job’s status.   What creates a 
mismatched job and how do you solve it so that you can 
continue printing? 

A media mismatch occurs when the size or type of 
media (paper) that is loaded in the printer is not 
correct for the print job. 
For any mismatched job shown in the Status 
column of the Job Queue, click on the Mismatched 
checkbox to obtain information about how to 
resolve the mismatch condition. 

12. What page does the Administrator access to select Optional as 
the Accounting Mode? 

[Configuration > Accounting]. 
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FreeFlow Account 
Management Tool (AMT) 

Module Introduction 

The Account Management Tool (AMT) application provides a means of 
retrieving job accounting data from multiple printers that use FreeFlow 
Accxes version 7.0 or higher firmware. This application replaces the 
Accounting Tab functionality of the FreeFlow Accxes Client Tools (ACT).  

NOTE:  It is recommended that the AMT software be loaded on only one 
workstation that is password protected. 

See the Xerox FreeFlow Accxes V13.0 Drivers and Client Software 
Installation Guide for more details on AMT and ACT installation. 

If you will be in charge of the AMT, then go through this training module. If 
you won’t be, then skip this module and go to the next module.  

Objectives 
When you have finished this module, you should be able to: 

• Install the AMT software 

• Assign Account IDs, User IDs, and Printer IDs 

• Authorize which users and account numbers can be used on 
specific printers 

• Retrieve media and scan usage data from the assigned printers 

• Tally retrieved data 

• Export data to an external software 

• Manually back up the data files 
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Materials Required 
You must have the following items before beginning this module: 

• A PC 

• The AMT software CD-ROM, or the executable file that has been 
downloaded from the www.xerox.com website 

• Wide Format Print System 510 Series, 721P, 6204, 6050A, 6279, 
or the 6030/6050 Wide Format printer with the FreeFlow Accxes 
Printer Server loaded with FreeFlow Accxes Firmware 13.0 

• The IP v4 or v6 address of at least one printer 

http://www.xerox.com/
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Install the Account Management Tool (AMT) and FreeFlow 
Accxes Client Tools (ACT) 

The ACT and the AMT software can be installed during the same 
installation. A password is required for the AMT installation because it 
should be loaded on only one computer and used by only one person per 
company. No password is required for installing ACT.  

After you have installed the Account Management Tool, you will be using 
several of the help files to complete this part of the training. 

If you downloaded the software from the xerox.com:  

1. Open the downloaded file. 

2. Extract the files. 

3. Select the install.exe file to start the install software. 

4. On the first install screen, choose the language. 

5. On the Enter Password screen, if you are loading both AMT 
and ACT, put in the password. Ask your System Administrator 
for the password. If you are installing just the ACT, press the 
Next button. 

6. Follow the directions on the screens. 

7. On the Choose Shortcut Location screen, choose where you 
want the shortcut to show, such as On the Desktop. 

8. On the Choose Install Set screen, select the FreeFlow Accxes 
Client Tools button to install only the ACT software. To install 
both ACT and AMT, select FreeFlow Accxes Account 
Management & Client Tools to install both ACT and AMT. You 
will need the AMT software for this training module. 
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For Windows: 

The Windows version of Accxes Client Tools installs the Document 
Retrieval, Document Submission Tools, Queue Tool, and Accounting 
Tool.  In general, the user requirements for this installation are: 

• Intel-based PC, 400 MHz or greater (1 GHz is recommended) 

• Windows Vista, Windows 2003, or Windows XP 

• Minimum 256MB RAM, 512MB recommended 

• 100MB free disk space (80MB application, 20MB free) 

• CD-ROM drive 

• 1024x768 minimum screen resolution 

• Permissions to install in the selected location 

 
To install using Windows: 

 
1. If auto-run is not enabled, installation may be accomplished by 

inserting the CD-ROM into the CD-ROM drive, opening the 
command line to the <CD-ROM mount 
point>\AccXES\Windows\VM\, and enter the command "install".  
You may also run the setup.exe file located at the <cd-rom 
mount point>.  

2. If auto-run is enabled, after you insert the CD-ROM into the CD-
ROM drive, the installer will automatically start and will lead you 
through the installation process. 

3. Load >CD-ROM mount point>\AccXES\install.htm into the 
browser.  Follow the instructions on the web page. 

 
Alternatively, the user can double-click on the files install.exe or 
install.htm after locating the aforementioned CD-ROM directories using 
the File Manager. 
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On a MAC OSX: 

The MacOSX version of Accxes Client Tools installs the Document 
Retrieval & Document Submission Tools, Queue Tool, and Accounting 
Tool.  In general, the user requirements for this installation are: 

 
• MacOSX 10.4.x or 10.5.x 

• Apple G4/G5/x86 

• 256MB RAM minimum, 512MB recommended 

• 100MB free disk space (80MB application + 20MB temporary) 

• CD-ROM drive 

• 1024x768 minimum screen resolution 

• Permissions to install in the selected location 

 

To install using a Mac OSX system: 

1. To install this application on a MacOSX system, insert the CD-
ROM into the CD-ROM drive and enter the following commands: 

2. At the top level of the install CD, right click (1 button mouse: 
control-click) on "setup.zip". 

3. Select "Copy "setup.zip"". 

4. Right click on the Desktop and select "Paste item". 

5. Double click on "setup.zip" on the Desktop. 

6. After the archive is expanded, double click on "install" on the 
Desktop. 

 
To install the application on a MacOSX system using a web browser, 
insert the CD-ROM into the CD-ROM drive and load >CD-ROM mount 
point>/AccXES/install.htm into the browser.  Follow the instructions on the 
web page. 

In all cases <CD-ROM mount point> is the directory where the CD-ROM 
is mounted.  Note that these commands may differ from that shown 
above, depending on the version of MacOSX being used. 
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On a Linux System: 

The Linux version of Accxes Client Tools installs the Document Retrieval 
& Document Submission Tools, Queue Tool, and Accounting Tool.  In 
general, the user requirements for this installation are: 

• RedHat Enterprise Linux/Suse 10.x Linux/Ubuntu Linux 

• Intel-based PC, 400 MHz or greater (1 GHz is recommended) 

• 256MB RAM minimum, 512MB recommended 

• 100MB free disk space (80MB application + 20MB temporary) 

• CD-ROM drive 

• 1024x768 minimum screen resolution 

• Permissions to install in the selected location 

To install using a Linux system: 

To install an application on a Linux system, insert the CD-ROM into the 
CD-ROM drive and enter the following commands: 

cd <CD-ROM mount point>/AccXES/InstData/Linux/VM/ 

./install.bin 

or 

cd <CD-ROM mount point> 

./setup.bin 

To install the application on a Linux system using a web browser, insert 
the CD-ROM into the CD-ROM drive and load >CD-ROM mount 
point>/AccXES/install.htm into the browser.  Follow the instructions on the 
web page. 

In all cases <CD-ROM mount point> is the directory where the CD-ROM 
is mounted.  Note that these commands may differ from that shown 
above, depending on the version of Linux used. 
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On a Solaris System: 

The Solaris version of Accxes Client Tools installs both the Document 
Retrieval & Document Submission Tools, Queue Tool, and Accounting 
Tool.  In general, the user requirements for this installation are: 

 
• Solaris 10 

• SPARC processor, minimum 1 GHz recommended 

• Minimum 256MB RAM, 512MB recommended 

• 100MB free disk space (80MB application + 20MB free) 

• CD-ROM drive 

• 1024x768 minimum screen resolution 

• Permissions to install in the selected location 

 
To install an application on a Solaris system, insert the CD-ROM into the 
CD-ROM drive and enter the following commands: 

cd <CD-ROM mount point>/AccXES/InstData/Solaris/VM/ 

./install.bin 

or 

cd <CD-ROM mount point> 

./setup 

To install the application on a Solaris system using a web browser, insert 
the CD-ROM into the CD-ROM drive and load >CD-ROM mount 
point>/AccXES/install.htm into the browser.  Follow the instructions on the 
web page. 

In all cases <CD-ROM mount point> is the directory where the CD-ROM 
is mounted.  Note that these commands may differ from that shown 
above, depending on the version of Solaris used. 
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System Requirements and Overview 

Read over the information in the Systems Requirements help file.  Do the 
following to locate the file. 

1. Select the AMT icon on your desktop to open the installed AMT 
software.  If it isn’t there, select Start > All Programs > Accxes 
> Account-Tool. 

 
2. Select Help > Help Topics at the top of the opened AMT 

screen. 

3. On the Index screen, select the System Requirements link. 

Read the information in the Overview help file. Do the following to locate 
the file. 

1. Select Help > Help Topics at the top of the screen. 

2. On the Index screen, select the Overview link. 
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Using the Account Management Tool  

Follow the instructions in the Tutorial help file to learn how to use the 
software. It might be easier to follow if you print out a copy of the file. 
Do the following to locate the file. 

1. Select Help > Help Topics at the top of the screen. 

2. On the Index screen, select the Tutorial link. 

Assigning Account IDs, User IDs, and Printer IDs 

Follow the instructions below to add an account to the Accounts 
Database. 

1. Select this toolbar button, or select Configuration > Add 
> Accounts. 

2. On the "Add Accounts" dialog, type the account identifier into 
the Account ID field. The Account ID is an alphanumeric 
character string (A-Z, 0-9), with a maximum of 32 characters. A 
decimal point . and minus sign - are allowed. If you use sub-
account numbers, they would need to be added as User IDs, or 
they can become part of the Account ID. For example, if you 
want to add account 3 and sub-account 2, you would type in 3.2 
as the Account ID. Lower case characters are converted to 
upper case letters on entry. When accounting is set to "optional" 
on the printer or scanner, any job log file data that does not have 
an Account ID will be assigned the "GenericAccountID". The 
Account ID is checked for valid characters when first entered 
into the AMT. Duplicate account numbers are not allowed. 
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3. Press this toolbar button after adding each Account ID. 
The Account ID will be added to the window at the bottom of the 
dialog screen.  
When attempting to add a duplicate account, a message box 
appears and tells the user they can't add a duplicate. Duplicate 
Account IDs are not allowed and will not be added to the 
database list. 

4. To associate the listed accounts to all printers and all users that 
are currently defined in the AMT database, select the checkbox 
in front of "Enable these accounts for all printers and users". The 
associations will be made to the AMT database, and the 
"Authorization Needed" checkmark will be checked on the 
Printers Tab. 

5. Select this toolbar button to apply the listed Account IDs to 
the AMT Accounts Database. 

6. Press the Close button. The Account ID and Creation Date will 
become visible on the Accounts Tab list.  
Account IDs may exist in the AMT Accounts Database without 
associations to users or printers.  

7. Select this toolbar button on the Printers Tab to also send 
the associations to the printers. 

8. To associate the added accounts with specific users and 
printers, select the Edit Account Associations Tab. 
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Backing up the AMT data files 

It is important to do a manual backup of the AMT database files on a 
regular basis.  If you accidentally corrupt or delete the saved AMT data 
files, they cannot be recovered. Your manually backed up files would 
then need to be copied into the AMT database folder. 

 
Go to the location of the data files. In the Windows environment, the 
default location of these data files is C:\ Program Files \Accxes\ 
AMTdatabase. In UNIX, the files are located inside the "AMTdatabase" 
folder that is found in the install directory (i.e., usually the "Accxes" 
folder). Make a backup copy of the AMT database files to a different 
location. The names of the files to back up are: Accxesjadb.backup, 
Accxesjadb.data, Accxesjadb.script, Accxesjadb.properties.  
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Check your understanding of the Account Management Tool 

1. Where do you specify that you are requiring all users to put in an 
Account ID and a User ID to track media and scan usage data? 

____________________________________________________ 
2. When the FreeFlow Accxes firmware is loaded, can the media 

and scan usage data be lost from the controller? Yes or No 

3. After you add account, user, and printer IDs to the AMT 
database, what tab should you select to start authorizing which 
users and accounts are assigned to each printer? 
____________________________________________________ 

4. Which toolbar button on the Edit Account Associations tab 
should you select to send the same authorizing (associations) 
information to the printers? This will allow the AMT and printers 
to communicate with each other, using the same accounting 
information. 
___________________________________________________ 

5. On which tab should you check if there are any data problems, 
which are indicated by checkmarks in the "Unvalidated", 
"Configuration Needed", "Authorization Needed", or "Purge 
Needed" columns.  
___________________________________________________ 

6. How do you retrieve the job accounting data that users created 
on the scan systems and printers? 
___________________________________________________ 

7. How do you tally the retrieved data? 
___________________________________________________
___________________________________________________ 

8. How do you export media usage data from the Raw or Tallied 
Job Accounting Database to external software? 
___________________________________________________ 

9. After exporting the tallied data, can the same data be exported 
again if the records are not deleted first from the Raw Job 
Accounting Database? Yes or No 

10. Data is automatically deleted in the Raw Job Accounting 
Database when the "Keep Raw Printer Records Interval" (days) 
is reached the next time that the AMT Administrator retrieves 
data from the printer’s job log files. Where is the Interval (days) 
specified? 
___________________________________________________ 
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Answers to AMT questions 

1. Where do you specify that you are requiring all users to put in an 
Account ID and a User ID to track media and scan usage data? 

Select Enabled on the Web Printer Management Tool 
Accounting page. 

2. When the FreeFlow Accxes firmware is loaded, can the media 
and scan usage data be lost from the controller? 
 
You need to save the data from each printer controller's job 
log file that is using pre - 7.0 FreeFlow Accxes firmware, or 
the data will be lost when a newer version of the firmware is 
loaded.  

3. After you add account, user, and printer IDs to the AMT 
database, what tab should you select to start authorizing which 
users and accounts are assigned to each printer? 
 
Go to the Edit Account Associations tab. 

4. Which toolbar button on the Edit Account Associations tab 
should you select to send the same authorizing (associations) 
information to the printers? This will allow the AMT and printers 
to communicate with each other, using the same accounting 
information.  
 

  Select this toolbar button. 
5. On which tab should you check if there are any data problems, 

which are indicated by checkmarks in the "Unvalidated", 
"Configuration Needed", "Authorization Needed", or "Purge 
Needed" columns.  
 
On the Printers tab. 

6. How do you retrieve the job accounting data that users created 
on the scan systems and printers? 
 
Go to the Printer Job Accounting Tab.   

Select this toolbar button to collect the job log file data 
from each printer, which includes the scan data. 

7. How do you tally the retrieved data? 
 

 On the Printer Job Accounting Tab, select this toolbar 
button. 
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8. How do you export media usage data from the Raw or Tallied 
Job Accounting Database to external software? 
 
On the Printer Job Accounting Tab, select whichever "View" 
toolbar button will display the data that you want to export (raw 
or tallied database data).  

 To export the currently displayed data, select this toolbar 
button. 

9. After exporting the tallied data, can the same data be exported 
again if the records are not deleted first from the Raw Job 
Accounting Database?  
 
Yes. 

10. Data is automatically deleted in the Raw Job Accounting 
Database when the "Keep Raw Printer Records Interval" (days) 
is reached the next time that the AMT Administrator retrieves 
data from the printers' job log files.  Where is the Interval (days) 
specified? 
 

 On the Printer Job Accounting Tab, select this 
toolbar button to access the "Select Job Accounting 
Options" dialog. In the "Keep Raw Printer Records Interval" 
field, enter the number of days. Select the Apply button 
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Operating in SCAN mode 

Overview 

This module discusses operation of the Xerox Wide Format 510 Series, 
721P, 6030/6050, 6050A, 6204, and 6279 Scan System in SCAN mode.  
Before we discuss the FreeFlow Accxes Client Tools Document Retrieve 
Tool, you should understand how to use the scanner to send documents 
to the controller's hard drive, or to an FTP destination. Then you will 
retrieve the documents using the FreeFlow Accxes Client Tools. 

You may have covered the use of the Xerox Wide Format Scan System in 
your product training. If you feel that you understand how to scan 
documents, you may proceed to the FreeFlow Accxes Client Tools 
section. 

If you are using a 6204 or 6279 and have a built-in scanner, see the 
Xerox 6204 Wide Format Solution Copy/Scan User Guide for the 
FreeFlow Accxes Print Server V13.0 or the Xerox 6279 Wide Format 
Solution Copy/Scan User Guide for the FreeFlow Accxes Print Server 
V13.0 for details on operating in scan mode on the User Interface. 

Introduction 

This module is only for use at sites where the Wide Format Print Systems 
510 Series, 721P, 6030/6050, 6050A, 6204, or 6279 Wide Format printer 
is connected to a network. The SCAN mode does not operate in non-
network installations. 

SCAN mode allows Scan-to-Net documents to be scanned and stored on 
the hard disk of the controller for later retrieval over the network by a 
remote workstation. Scanned documents can also be sent to an FTP 
destination and the files are not stored on the controller. If you do not 
have such a network connection and this functionality is of interest to you, 
contact your Xerox representative or authorized reseller to arrange such 
an installation. Training in SCAN mode operations will then be conducted 
after the network installation is complete. 
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Objectives  

When you have finished this module, you should be able to: 

• Ensure that the TCP/IP network protocol is enabled on the 
controller using the Web Printer Management Tool 

• Switch from COPY mode to SCAN mode and back again 

• Scan in documents and interpret the display information 

• Delete the most recently scanned image 

• Delete all the images previously scanned 

• Set the FILE DELETION timer to adjust the time that a scanned 
file is retained before automatic deletion 

• Scan a document to an FTP Destination 

 
Materials required  
You must have a Xerox Wide Format Scan System with an activated 
Scan-to-Net feature Key before beginning this module. 

 

Scan Mode 

In COPY mode, the image is sent immediately to the printer. However, in 
SCAN mode, the Scan-to-Net image is not printed, but is retained in the 
controller’s Scan Directory for the period of time set by the FILE 
DELETION timer and then automatically deleted. The stored images can 
later be retrieved from a network-connected workstation.  

The Scan-to-FTP image is scanned and sent to an FTP Destination, with 
no file being saved in the local controller. 

Scanned files may be retrieved over the network by any of the following 
means: 

• The FreeFlow Accxes Client Tool’s Document Retrieve Tool 

• A File Transfer Protocol (FTP) client 

• A Web browser that supports FTP 

The Client Tools Document Retrieve Tool is the recommended retrieval 
tool, since it automatically manages space on the controller by deleting 
retrieved files from the controller’s hard disk. 

Use of the Document Retrieve Tool is explained in the FreeFlow Accxes 
Client Tools section of this training guide, in the Quick Start section. 
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Entering SCAN mode 

Entering Scan Mode using the Xerox Wide Format Scanner: 
To switch to Scan mode using the Scanner Control Panel, first obtain the 
READY TO COPY screen. Press the <Mode> key.   

Type in the name of the Scan Directory to which you will be scanning and 
retrieving images. The default directory is “images”.  

Press the <ENTER> key. 
The screen switches to the READY TO SCAN screen, as shown in the 
following Figure. 

 
 
 
 
 
 

 
 
 

Figure 1.  Xerox Wide Format Scanner READY TO SCAN screen 
 

Entering Scan Mode using the 6204 with a built-in scanner: 
To enter Scan mode, press the [Menu] button, and then the [Scan] 
button.  

 
Figure 2.  6204 Scan screen when using the 6204 built-in scanner option 

READY TO SCAN 
INSERT DOCUMENT 

 
  400 DPITIFF/CCITTG4 

1 BIT 

EnterNext Exit Mode Menu Previous
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Entering Scan Mode using the 6279 with a built-in scanner: 
To enter Scan mode, press the <Services> button, and then select [Scan 
to Mailbox] or [Scan to Network].  

 
 

  Figure 3.  6279 Scan to Mailbox screen when using the 6279 built-in scanner 
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For the Xerox Wide Format 6279, a Color Feature Key license is needed 
for scanning colored images. To select the file format for color scanning 
in Scan Mode, go to the Image Quality section of the scanner control 
panel and select Photo & Normal. In the Ready to Scan screen select 
Next > Format > Enter >, then JPEG, TIFF, or PDF, then Enter.  

 
NOTE:  Printer default color settings are made on the Web Printer 
Management Tool. Color settings for individual print jobs, or individual 
documents, are made from the Document Submit Tool, which is part of 
the FreeFlow Accxes Client Tools. 
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Operations in SCAN mode: machine observations for Scan-to-Net 

Record your observations as you perform each activity. 

Go to the Xerox Wide Format Copy System User Guide (check the Index 
for the page numbers) and read the sections entitled "Understanding the 
READY TO SCAN screen", "Selections disabled in SCAN mode", and 
"Operating in SCAN mode."  

1. Select a document and scan it. Observe the following icons: 

 
 

2. What happens to the arrow?  What does the dark area signify? 

____________________________________________________ 
____________________________________________________ 

3. What then happens to the cylinder?  

____________________________________________________ 
____________________________________________________ 

4. What does the dark area on the cylinder signify? 

____________________________________________________ 
____________________________________________________ 

5. Press the Mode key and observe the LEDs in the Media 
Selection part of the scanner control panel. Press the Mode key 
again. What happened?  Why? 

____________________________________________________ 
____________________________________________________ 

6. Go to the Xerox Wide Format Copy System User Guide and 
read the "Clearing the scanned images" section (Check the 
Index for the page number). 

 
Press the C/CA key. Follow the procedure in the user guide to 
clear all images. What change did you observe in the cylinder 
icon?  Why did the change occur? 

____________________________________________________ 
____________________________________________________ 

 

NOTE:  Normally, when a document is scanned, two files are created and 
stored on the hard disk in the controller. A small preview image is stored 
as a JPEG file, while the high-resolution image is stored as a TIFF Group 
6, PDF, or CALS1 file.  When an image is retrieved using the DRT, only 
the high-resolution image is retrieved. If the Create Preview option is 
disabled, then the preview file is not created. 

When you have finished, proceed to the Machine Observations - 
Feedback Sheet on the next page. Check your understanding. 
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Machine observations - feedback sheet  

1. Select a document and scan it. Observe the following icons: 

 
 
 

2. What happens to the arrow?  What does the dark area signify? 

The arrow becomes partially filled with a dark area.  Then 
the arrow becomes empty again.  The dark area represents 
the amount of Random Access Memory (RAM) used. 

3. What then happens to the cylinder?  

The cylinder becomes partially filled with a dark area. 
4. What does the dark area on the cylinder signify? 

The dark area signifies the amount of hard disk space being 
used by stored files. 

5. Press the <Mode> key and observe the three LEDs in the Media 
Selection part of the scanner control panel.  Press the <Mode> 
key again.  What happened?  Why? 

The LEDs extinguished when the Xerox Wide Format Scan 
System was In SCAN mode. This is because those features 
are disabled in SCAN mode. 

6. Press the C/CA key.  Follow the procedure in the user guide to 
clear all images. 

What change did you observe in the cylinder icon?  Why did the 
change occur? 

The dark area in the cylinder disappeared, because all the 
files were deleted, and all the hard disk space was released. 
The FILE DELETION Timer. If scanned files were to remain 
on the hard disk, the disk would soon be full. To manage 
this problem automatically, the system deletes files that 
exceed a certain age. The feature that permits setting the 
allowed storage time is the FILE DELETION Timer. 
The default setting is 24 hours.  With this setting, files 
created more than 24 hours ago will be deleted by the 
controller. The setting may be changed to any value 
between 1 and 24 hours in increments of 1 hour. 
Press the <Menu> key. Select CONFIGURATION, and press 
Enter. Select TIMERS, and press Enter. Press Next to select 
FILE DELETION, and press Enter. 
Enter a value between 1 and 24. Press Enter.  Any scanned 
files older than the new value will be deleted by the system. 
Press Menu to return to the READY screen. 
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Scan-to-FTP or remote printer 

This feature works on all printers with a scanner and STN Feature Key 
loaded, 2GB of RAM for Total Accxes, and Immediate Image Overwrite 
turned off. Scanned images can be transferred to up to 16 remote FTP or 
remote printer destinations, which are defined on the Web Printer 
Management Tool on the Configuration > Scanner screen. The scanned 
images are not stored on the Controller’s hard drive. The FTP feature is 
located on the Scan System’s Sample Mode screen. 

Practice the Scan-to-FTP or remote printer feature as follows. 

1. Go to the Web Printer Management Tool. Select Configuration 
> Scanner to see the 16 defined FTP destinations.  

2. At a Wide Format Scan System, select the SCAN mode. 

3. Select the Sample option and select the Destination to where 
you will send a scanned file. 

4. Scan the document. 

5. View the FTP directory to see that the scanned file has been 
sent there. 

See your 6204 or 6279 User Guide for User Interface instructions on 
scanning to FTP or remote printer destinations. 
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FreeFlow Accxes Client 
Tools 

Module overview 

The FreeFlow Accxes Client Tools (ACT) application runs on your PC or 
Solaris workstation.   

The Client Tools are used to print, retrieve, and save images using a 
Wide Format Print System 510 Series/ 721P, 6204, 6279, 6030/6050, or 
6050A Wide Format printer with an enabled Scan-to-Net Feature Key, 
and a Xerox Wide Format Scan System. A Color Feature Key is required 
for color scanning to the network.   

Document sets can be created and saved as a single document. The 
printer queue can be viewed, and submitted print jobs can be canceled. 
When job accounting is enabled, media usage data can be tracked by 
assigning a User ID and Account ID to the scanned and copied 
documents. A Scan Directory is also specified before scanning 
documents. Each of the Client Tools is on a separate tab: Document 
Submit, Printer Queue, Accounting, Document Retrieve, and Device 
Management tabs. All of the tools are installed at the same time, using 
the Install Anywhere software. 

NOTE: The Accounting tab functionality is available only if the printer with 
which the Client Tools interact is using a firmware version less than 7.0. 
The firmware version number will be indicated at the bottom of the Device 
Management tab for the selected device.   
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NOTE: Whatever ACT option choices that you make will override the 
Web Printer Management Tool default job option selections if the two are 
different for the same feature. 

Objectives 
When you have finished this module, you should be able to: 

• Connect to an FreeFlow Accxes supported scanner and Wide 
Format Print System using the Device Management Tool 

• Use the Document Retrieve Tool to retrieve and save scanned 
documents 

• Create, print, and save document sets using the Document 
Submit Tool 

• View and cancel a submitted print job, using the Printer Queue 
Tool 

• Know how to use a User ID and Account ID to print jobs and scan 
documents so that media usage will be logged in the controller's job 
log file.   

 

Materials required  
You must have the following items before beginning this module: 

• FreeFlow Accxes Client Tools software  

• FreeFlow Accxes Help files, which are accessed from the Client 
Tools software. 

• Wide Format Print Systems 510 Series/ 721P, 6204, 6050A, 6279, 
or 6030/6050 Wide Format printer with an accounting license and 
Scan-to-Net license installed. Note that the Color Scan-to-Net 
feature requires a separate Color Feature Key (license). 

• Xerox Wide Format Scan System 

• FreeFlow Accxes Account Management Tool or some other 
External Accounting Server 

• Your Subnet Mask, IP Address, and Gateway settings 

• User ID, Account ID, and Scan Directory name for using the 
printer and scanner 

• A stamp file 
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Using the Client Tools 

Installing the Client Tools  

Do the following to install the ACT software. (If you did the AMT module in 
this document, then it is already installed and you can skip this section.)  

1. Insert the Client Install CD into a CD-ROM. 

Or 

2. If you downloaded the software from the www.xerox.com 
website:  

- Open the downloaded file. 

- Extract the files. 

- Select the install.exe file to start the install software. 
3. On the first screen, choose the language. 

4. On the Enter Password screen, press the Next button. 

5. Follow the directions on the screens. 

6. On the Choose Shortcut Location screen, choose where you 
want the shortcut to show, such as On the Desktop. 

7. On the Choose Install Set screen, choose the FreeFlow 
Accxes Client Tools button to install only the ACT software. 
You will need the ACT software for this training module. 

Configuring Your Network Connections  

At the printer Control Panel or Web Printer Management Tool, check that 
the Subnet Mask, IP Address, and Gateway settings are correct. These 
are needed so that your workstation will be able to communicate with 
your FreeFlow Accxes compliant scanner and printer.  

For all Wide Format Print Systems: 
On the Web Printer Management Tool, select [Configuration > Network 
> TCP/IP]. 

 
For the Wide Format Print Systems 510 Series, 6204, and 6279, you 
may check network settings on the user interface as well: 

On the printer Control Panel, press the button to take the printer off 
line.  Press the Enter button. Go through the menu choices to select 
Setup IO Ports, Ethernet TCP/IP, TCP/IP Address, Gateway, and Mask. 

http://www.xerox.com/
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For the 6050A: 
From the [Menu] screen, select System Settings and check the settings. 

 
For the 6204: 
From the [Menu] screen, select the [Setup] button. Select the [Network 
Settings] button. Select [DHCP] and set it to [Off] or [On] and then select 
[Save]. Then select the [TCP/IP] button and check the IP Address, 
Subnet Mask, and Gateway settings.  

 
For the 6279: 
Press the <Services> button on the Control Panel, then select [Printer 
Information > Administration > Network Settings] and check the 
settings. 

Connecting to the printer and scanner 

1. Open Accxes Client Tools. 
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2. Select the Device Manager tab from the Accxes Client Tools 
application. 

 
3. Click on the Device Name of the FreeFlow Accxes-compliant 

printer with which you want to communicate from your PC. A 
system administrator must have already set one up. 

4. To the right of the selected Device Name, click in the Default 
Printer and Default Scanner columns to select the default 
printer and scanner to be used by the Client Tools. 

5.   If your devices are not listed, select the Create a new 
device toolbar button. At the bottom of the screen, type in a 
name that you will recognize for the device and its IP v4 and v6 
address.  

The Domain Name Server (DNS) option can be used to look up 
DNS registered names if you do not know the IP Address and 
the name of the Accxes controller that is registered on the DNS. 

6.   Select the Accept the device parameters toolbar 
button to save it in your device list, and then select it as the 
default. 
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Logging media usage accounting data 

To use the accounting feature, your printer needs to have an accounting 
license. The Account Mode also needs to be set to “Optional” or 
“Enabled” on the printer or scanner via the Web Printer Management Tool 
or the User Interface. 

Go to the Device Management tab’s Printer Identification section at the 
bottom of the screen. Notice the Firmware version for the selected device. 
If the information is not present, select the ID toolbar button for the Device 
Management Tool to get that information from the printer. 

If your Client Tools are connected to a printer that is using firmware 
version 7.0 or higher, an External Accounting Server, such as the 
FreeFlow Accxes Account Management Tool (AMT), will be keeping track 
of multiple printers' scanned and printed media usage. This is replacing 
the functionality of the Accounting tab. 

If you are the Account Management, go to the FreeFlow Accxes Account 
Management Tool section of this document to learn how to install and use 
the tool. 

If you are a user, as you learn how to use the scan system, Document 
Submit Tool, and the Document Retrieve Tool, you will learn where to add 
a User ID and Account ID to have your printed and scanned media usage 
logged on the controller. The AMT will retrieve the logged data from the 
controller for accounting purposes. 
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Retrieving scanned documents 

Select the Document Retrieve tab. This is where you can preview and 
retrieve the images, which you scanned to a Scan Directory. The scanned 
images are temporarily stored in the specified controller’s Scan Directory. 
You can retrieve and save the scanned images to your file system or 
send them to the Document Submit tool to add them to a document set.  

If you are using a 6204 or 6279 printer, mailboxes require a username 
and password. ACT auto-detects if a password is required and displays 
the appropriate screen. The username is the mailbox name and the 
password is User Interface defined. 

You will be using the Quick Start help file for several sections of this 
module. It may be easier to print it out to use. To locate the file, do the 
following: 

1. Open the ACT software. You will be on the Document Submit 
tab. 

2. Select [Help > Help Topics]. 

3. Select [Master Index > Quick Starts]. 

Practice the Document Retrieve features by going to the "Quick Start - 
Document Retrieve Tool" section of the Quick Start help file.  You will be 
asked to scan some images and then preview, retrieve, and save them. 



 

54                                                                                 FreeFlow Accxes Software Tools Customer Training Guide 

Creating, printing and saving document sets 

The Document Submit tab is where a user creates a document set by 
adding document files to the Document Submit window. The user may 
edit default document options, the job options associated with the entire 
document set, or an individual document’s printing options. The document 
set is sent to the printer from the Document Submit window. Document 
sets can be saved as a single file. 

1. Select the Document Submit tab. 

 
2. Go to the "Quick Start - Document Submit Tool" section of the 

Quick Start help file.  Follow the steps for adding several 
documents of the correct file type to the Document Submit 
screen, changing some options, printing the set of documents, 
and then saving them as a single file. 

NOTE:  The Document Submit Tool has three sets of pages that you can 
access to change either default document print options, individual 
document print options, or job options. 
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Default Document Options  

Select this toolbar button to go to the default document print 
options. 

Document Options for Individual Documents 
Double click on the file name in the Document Submit window to go to the 
individual document print option tabs. 

Job Options  

Select this toolbar button to access the job option tabs. These 
options will apply to all of the documents within the document set. 
  

Plot Nesting feature 

Plot nesting is a feature that will allow documents in your document set to 
print out on a single piece of media. 

  On the FreeFlow Accxes Client Tools’ Document Submit tab, 
select the Job Options toolbar button, and then the Composition tab.  
Make your Plot Nesting choice in the drop down menu. 

The “Off” setting will cause the printer to print out your documents on 
individual pages. If you choose “Single Job,” the controller will 
automatically nest (group) your submitted documents, in a row, onto a 
single media.  Selecting “Default” will use the printer’s plot nesting default. 
You must select “Off” to enable the page composition options. 
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Labels and Stamps features 

Labels and stamps can be applied to entire print jobs or to selected 
documents within a document set. An example of a stamp is a company 
logo. A label can be any text that you want to use as a label for your 
documents. You can choose where you want the label and stamp located 
on the document and whether it should be rotated. 

1.   On the Document Submit screen, select the Job 
Options toolbar button.  On the Labels tab, select the Apply 
Label box.  On the Stamps tab, select the Apply Stamps box.  

NOTE:  These two boxes need to be enabled here for both job option 
labels and stamps, as well as to activate these features on the individual 
document’s Labels and Stamps tabs. 

2. On the Labels tab, type the text into the Label field that you 
would like to use for your label.   

o Select the Help button to access more information about 
the Label choices. 

o If you want the label to appear on all of your documents 
in this set, be sure that you are on the Job Options 
Labels tab.  

3. On the Labels Tab, select the OK button to accept your 
selections. 

 
NOTE: If you want to put a label on a selected document in your 
document set, then double click on that document title on the Document 
Submit screen. Then select the Labels tab. 

 
Print out your document set.  Notice the location and wording of the label. 

Practice adding a stamp to a document. 

1. On the Stamps tab, select the Help button to access more 
information about the Stamp choices. 

o If you want the stamp to appear on all of your documents 
in this set, be sure that you are on the Job Options 
Stamps tab. 

2. On the Stamps tab, select the OK button to accept your 
selections. 
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Using the Printer Queue and Media Mismatch feature 

1. Select the Printer Queue tab. 

 
2. Read the "Quick Start - Printer Queue Tool" section of the Quick Start 
help file.  

This section explains which toolbar buttons to select for viewing a print 
job that you sent to the printer from the Document Submit tab. It also 
explains how to cancel a submitted print job. 

3. Go to the Web Printer Management Tool.  Select [System Defaults > 
Media]. Check the “Enabled” box next to Mismatch Queue.  When it is 
enabled, it will allow your print jobs to go to a mismatch queue while the 
remaining print jobs finish printing. Then you can select your preferred 
method to resolve the mismatch. You specify the method for handling the 
mismatch for each of the bond, vellum, and film media options. The 
choices for each media type are Query, Scaling, and Substitute.  
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4.  On the Document Submit screen, select the Job Options 
toolbar button.  

• Select the Finishing tab Help button. 

• Read over the Media Mismatch section and make your media 
mismatch selection of Query, Scaling or Substitute Media. 

• Select the [OK] button. 

5. Go back to the Document Submit tab, where you have listed various 
documents that you want to send at one time to the printer. 

6.  Select the [Printer Document Set] toolbar button to send the 
print job to the printer. 

7. If you want to save this set of documents as a single file, select File, 
Save on the Document Submit tab toolbar menu. 
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Check your understanding of the FreeFlow Accxes Client Tools 

1. Can a group of documents that you have added to the 
Document Submit screen be saved as a single file? Yes or No 

2. How can you put a label on a document within a set of 
documents, but not on the whole set of documents? 
___________________________________________________ 

3. Where must you first enable the media mismatch feature for 
your mismatched print jobs to go the mismatch queue and let 
the other print jobs continue printing? 
___________________________________________________
___________________________________________________ 

4. Which of the FreeFlow Accxes Client Tools would you use to set 
up the network connection from your workstation to a different 
scanner and printer? 
___________________________________________________ 

5. Document sets are sent to the printer by selecting the printer 
toolbar button.  It is located on which client tool? 
___________________________________________________ 

___________________________________________________ 

6. Which client tool tab allows you to view the progress of a 
submitted print job? 
___________________________________________________ 

7. Where does the account mode need to be enabled first before 
you can use the accounting feature? 
___________________________________________________
___________________________________________________ 

8. Where do you indicate to which Scan Directory you want 
scanned images saved until you retrieve them to your file 
system? 
___________________________________________________
___________________________________________________ 

9. Where do you indicate which documents or images you want to 
retrieve from the scanner? 
___________________________________________________ 

10. Where do you indicate the User ID and Account ID to which you 
want printed jobs logged? 
________________________________________ 
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Answers to FreeFlow Accxes Client Tools questions  

1. Can a group of documents that you have added to the 
Document Submit screen be saved as a single file? 

Yes 
2. How can you put a label on a document within a set of 

documents, but not on the whole set of documents? 

On the Document Submit screen, go to the Job 
Options button, Labels tab.  Select the Apply 
Labels box and OK button.  On the Document 
Submit window, double click on the document title. 
Go to the Labels tab that will come up to make your 
label choices. Select OK. 

3. Where must you first enable the media mismatch feature for 
your mismatched print jobs to go the mismatch queue and 
let the other print jobs continue printing? 

Go to the Web Printer Management Tool and select 
[System Defaults > Media]. In the Mismatch Queue 
field, select the “Enabled” checkbox. 

4. Which of the FreeFlow Accxes Client Tool tabs would you 
use to set up the network connection from your workstation 
to a different scanner and printer? 

The Device Management Tool tab 
5. Document sets are sent to the printer from selecting the 

printer toolbar button. It is located on which client tool? 

The Document Submit Tool 
6. Which client tool tab allows you to view the progress of a 

submitted print job? 

The Printer Queue Tool 
7. Where does the account mode need to be enabled first 

before you can use the accounting feature? 

On both the printer or scanner 
8. Where do you indicate to which Scan Directory you want 

scanned images saved until you retrieve them to your file 
system? 

On the scanner, if the accounting feature is 
enabled, put in your User ID and Account ID.  Press 
the Mode button to select Scan Mode. Type in the 
Scan Directory name, and then scan in the 
documents. 
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9. Where do you indicate which documents or images you want 
to retrieve from the scanner? 

In the Scan Directory field on the Document 
Retrieve tab 

10. Where do you indicate the User ID and Account ID to which 
you want printed jobs to get logged? 

On the Document Submit tab if you are sending 
files to get printed from your workstation. 
On the scanner if you are scanning documents to 
print out. 
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